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Introduction 

This document is to serve as an official standard regarding the Validation of Tizen 

applications. It explains in detail what types of defects are frequently detected during 

validation. Please refer to the latest version of the document. 

 

Purpose 
The purposes of this document to introduce top 5 validation issues that may result in 

validation reject. This document can help developers to escape from getting rejected from 

validation by providing defects in real cases and tips to avoid reproducing them.  

 

Scope 
This document covers Tizen application validation based on the Tizen Validation Guide.  
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Top 10 Certification Failures and Tips 

1.1 Icon Problems 
 

 
 Not in compliance with the following Validation guidelines. 

 • 3.1.12 The main icon represents the application and it is  

recommended to be a circular shape. 

• 3.2.1  Icon, screenshot, description, supported language and tag  

in the Tizen Store should be consistent with those installed 

on device 

 
 
 

Defect Examples 
 

  

1.  Mischoice of Icon itself, shape and size.  

1-1) Icon Image:  

- Defect: Icon is the default Tizen icon. 

- Solution: Seller should use own icon. 

1-2) Icon Shape:  

- Defect: Icon shape is not a circle. 

- Solution: Icon is recommended to be 

 circled one. 

1-3) Icon Size:  

- Defect: Icon size is out of 

recommendations. 

- Solution: The launching icon is a circle 

one of 117px size. 

       The registered icon is a circle one of 

512px size. 
 

2.  Inconsistency of icon image and name. 

2-1) Icon Image Inconsistency:  

- Defect: Registered and launching icon 

 images are different. 

- Solution: Registered and launching  

icon images should be same. 

2-2) Icon name Inconsistency:  

- Defect: Registered and launching icon 

 names are different. 

- Solution: Registered and launching  

icon names should be same. 

 
 

Self-check list 
 

■ [I-2] Registered application name, icon, screenshots and supported language should be inconsistent 
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 with installed one on device. 
■ [VI-2] Icon shape is recommended to be a circular one. And size for a mobile device which is shown 
 on the real device is 117 x 117 pixels, and size for a store which is shown on the Tizen web site is 
 512 x 512 pixels. 

 

TIP to solve this issue: 
 

■ Icon shape and size guideline:  

https://developer.tizen.org/documentation/ux-guide/visual-style/icons  

https://developer.tizen.org/documentation/ux-guide/visual-style/icons
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1.2 App Privilege & Integrity 
 
 

Not in compliance with the following Validation guidelines. 

• 4.3.1 Application that uses a method of privilege that is not 

 specified in the manifest file will be rejected. 

• 4.3.2 Application that uses system privilege level without  

permission will be rejected. 

• 4.3.3 Application that uses programming interface embedded in the 

 official SDK but not specified as official Tizen API’s 

shall be rejected. 

• 4.3.4 Application that does not use any method of privilege defined  

in the manifest file will be rejected. 

 
 
 

Defect Examples 
 

1. Privilege Problem. 
 
1-1) Unused Privilege Problem. 

- Defect: Application does not use some of methods belong to a defined privilege in the 
config.xml file.  

- Solution: Application should use all of methods belong to a defined privilege in the config.xml 
file. 
 

1-2) Undefined Privilege Problem. 

- Defect: Application uses undefined privilege in the config.xml file. 

- Solution: Application should not use unauthorized privilege in the config.xml file.  
 

1-3) Privilege Violation Problem 

- Defect: Application contains the privileged API of privilege group which is not specified  
in the manifest.xml file. 
 

-    Solution: Check the privilege usage using the privilege checker tool in the IDE by selecting 
 Project > Check privilege. Then checking results will be displayed as alarms.  
To resolve an alarm, click the annotation on the vertical ruler and select an entry from  
the proposal list. The required privilege is automatically added into config.xml file  
(for a quick fix, use the Ctrl+1 keyboard shortcut). 
 

2. Author Signature does not exist. 

- Defect: Application package is not signed to identify the author of the application and to 
verify application integrity. 

-   Solution: Develop your application using the latest Tizen SDK(ver2.2), then signature will be 
generated automatically during packaging. But if you want maintain an application based  
on ver 2.1, you can create the signature using the ‘Certification Generator Too’ 

 

 

TIP to solve this issue: 
 

■  Build your application on the latest SDK as possible. (SDK2.2) 

■  For more information, please refer to the URL below. 
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1. Privilege 

1-1. Web 

https://developer.tizen.org/documentation/dev-guide/2.2.1 

Tizen Native App Programming > IDE and Tools > Native IDE 

  > API and Privilege Checker 

1-2. Native 

https://developer.tizen.org/documentation/dev-guide/2.2.1 

Tizen Web App Programming > IDE and Tools > Web IDE >  

Privilege Checker 

2. Application Signing 

https://developer.tizen.org/documentation/dev-guide/2.2.1 

Getting Started with Tizen > Overview > Security Architecture > 

Application Signing 

 

  

https://developer.tizen.org/documentation/dev-guide/2.2.1
https://developer.tizen.org/documentation/dev-guide/2.2.1
https://developer.tizen.org/documentation/dev-guide/2.2.1
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1.3 Back Key Malfunction 
 
 

Not in compliance with the following Validation guidelines. 

• 3.1.9  Application should not crash or cause malfunctions due to  

H/W usage.  

(e.g. MENU, HOME, BACK, VOLUME, HOLD key) 

• 3.1.10 H/W key itself should work as user can normally expect  

when user executes application. 

 
 
 

Defect Examples 
 
 
 

1.  Back Key does not work.  

- Defect: Application does not work properly  

with Back Key event. 

- Solution: Application should go to the previous page 

or be terminated with Back key interruption. 

 

2.  Malfunction of Back Key. 

- Defect: Application is terminated by force  

when user presses Back key. 

- Defect: Application gets frozen when user presses 

 Back key. 

- Defect: Application shows pop-up or error message  

when user presses Back key. 

 

 
 

Self-check list 
 

■ [Ⅳ-6] Application should operate without any problems when user presses H/W KEY  

while application is running (BACK, CAMERA, etc.). 

 

TIP to solve this issue: 
 

■  Since Tizen 2.2, the physical Menu and Back keys are mandatory part of Tizen.  

Therefore, your application should be built on higher than SDK 2.2 version to handle  

physical keys properly. 

■  For web application, you can bind event handlers on the ‘tizenhwkey’ event to handle  

physical Menu and Back key. Please refer to below code example. 

// Javascriptcode 
$( window).on( "tizenhwkey", function ( ev ) { 

if ( ev.originalEvent.keyName === "back" ) { 
//call browser back if webApp dev. wants back behavior 
window.history.back();  
//add script if there is a need to add another behavior  
// on H/W back key press 
} 
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} 
 

 
■  For native application, you can use IFormBackEventListener and IFormMenuEventListener  

to handle physical Menu and Back keys since Tizen 2.2. Please refer to below code example. 

class HWKeyForm  
: public Tizen::Ui::Controls::IFormBackEventListener  
, public Tizen::Ui::Controls::IFormMenuEventListener  

{  
public:  

// IFormBackEventListener  
virtual void OnFormBackRequested(Tizen::Ui::Controls::Form& source);  
 
// IFormMenuEventListener  
virtual void OnFormMenuRequested(Tizen::Ui::Controls::Form& source);  

};  

 

■  For more details on how to handle physical Menu and Back keys,  

please refer to the “Application Migration Guide – Tizen 2.1 to 2.2”.  

https://www.google.co.kr/url?sa=t&rct=j&q=&esrc=s&source=web&cd=1&cad=rja&ved=0CDEQFjAA&url=https%3A%2F%2Fwww.tizenportathon.com%2Fbada%2Fboard%2F%2FtechnicalResourcesPro1.do&ei=uWGhUvasB4XrlAWGtoCQBw&usg=AFQjCNFR2--HLfe6PiC8v48nGQMxu1kOVw&sig2=FpJKj4kCXuP
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1.4 Basic Functions do not exist or work properly 
 
 

Not in compliance with the following Validation guidelines. 

• 3.1.4 Application should provide functions according to the 

 description or help. 

• 3.1.5 Each feature of application should work without malfunction. 

• 3.1.7 If application’s function does not work as expected, 

it will be rejected. 

 
 
 

Defect Examples 
 

 
 

 

 

1.  Does not provide functions as explained  

in the description or help. 

- Defect: Some of the functions described in 

 description are not provided in application. 

- Solution: Certain functions should be provided 

 according to the description. 
 

2.  Occurring malfunctions. 

- Defect: Unexpected pop-up or error message 

 Appears when user tries to user application functions.  

- Defect: Application works in a wrong or unexpected 

 way when user selects one of the menus. 

- Defect: Linked website is not connected.  

- Solution: Application functions and menus should  

work properly without any kinds of malfunctions. 

 

3.  UI without any function. 

-   Defect: Nothing happens when user selects menu. 

                                       -    Solution: All UIs should have its function and 

  response when user presses. 

 
 

Self-check list 
 

■ [Ⅲ-1] All the menus and functions operate successfully without any problems. 

■ [Ⅵ-5] Menu name should be related to its content to let users identify application functions. 
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1.5 Fail to Install, Execute or Terminate Application 
 
 

Not in compliance with the following Validation guidelines. 

• 3.1.1 Application should be installed on its target device  

without any errors. 

• 3.1.3 Application should be launched within 10 seconds after  

clicking the icon unless there is a visual indication of progress. 

• 3.1.8 It should be possible to remove application without any errors. 

 
 
 

Defect Examples 
 

 
 

 

1.  Application fails to be installed.  

- Defect: Application file can’t be installed because of 

 its invalid format file type.  

- Defect: User cannot download essential data even if  

        the network is available. 

    -    Solution: Application should be installed successfully. 
 

2.  Application fails to be executed.  

- Defect: Application is terminated by force  

right after executing application.  

- Defect: Application is not opened and shows no 

 response when user clicks icon. 

    -   Solution: Application should be executed successfully. 
 

3.  Application fails to be terminated. 

 

 
 

Self-check list 
 

■ [Ⅱ-1] The size of apk file*4MB (multiplied by 4MB) must not exceed the internal memory of device. 

■ [Ⅱ-2] Application must be installed for the targeted devices without any problems. 

■ [Ⅱ-3] Application must be uninstalled as user expects. 

■ [Ⅱ-4] Application should be executed without any problems. 

■ [Ⅱ-5] Application must be closed without any problems by following options. 

      - 5-1) Using the exit option in application 

      - 5-2) Using the Task Manager 

■ [Ⅵ-1] It should be possible to reinstall the deleted application on the device. 

 

TIP to solve this issue: 
 

■  Developer can use the Samsung RTL (Remote Test Lab) to test and tune the application  

before submission. 

■  Check if your target device is whether ARM based or Intel 80386 based because your native 



page 11 / 11 

 

 application is failed to execute if the file type of .exe file is not suitable for your target device.  

■  If your application is a multi-thread application, please make sure that UI handling is done only  

in the main thread since the Tizen UI framework is not thread safe. If not, your application may 

cause execution or termination failure unexpectedly depending upon the race condition among the 

threads. Please refer to this link for more details on multithreading with the UI framework. 

 

https://developer.tizen.org/dev-guide/2.2.0/org.tizen.native.appprogramming/html/guide/ui/multithread_ui_framework.htm

